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Implementation Plan Template 
The STOP Formula Grants Implementation Plan Template (Template) was designed to be used in 
the creation of a STOP Implementation Plan (STOP IP) that is required to be submitted to the 
Office on Violence Against Women (OVW) every four years. While use of the Template is not 
required, it offers several advantages over use of a previously submitted STOP IP or starting with 
a blank document.  

The Template:   

 Incorporates all relevant VAWA 2013 statutory requirements and the 2016 STOP regulations; 

 Tracks the OVW Implementation Plan Checklist (OVW Checklist) contained in the STOP 
Formula Grant Program solicitation; and  

 Includes annotations with guidance and links to resources.  

The Template was designed to be used in conjunction with the STOP Formula Grants 
Implementation Plan Guidance Tool (IP Guidance Tool), also produced by the STAAR Project. Both 
the Template and the Tool track the OVW Implementation Plan Checklist. The IP Guidance Tool 
Tool provides more extensive guidance, examples, and suggestions for how to address the 
elements that must be included in your STOP IP.  

Template Features 
The Template is designed to assist States and Territories in the creation of a STOP IP by allowing 
you to:  

 Enter content into a pre-formatted document with a structure that matches and tracks the 
OVW Implementation Plan Checklist (incorporated into the OVW STOP Formula Grants 
Program solicitation package).  

 Save personalized content in a new Word document while retaining the integrity of the 
original Word template. Once changes are saved as a separate Word document with a unique 
title, the Template can be used to create a new STOP IP.   

 Type text into a content control field directly underneath each STOP IP element. Each field 
provides a frame for content.  

 Eliminate the content control fields if you wish, to use a different structure or order of 
elements.  

 Insert pages, sections, tables, graphics, and other features throughout.  

 Access original sources including STOP program statutes and regulations, secondary 
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resources, and guidance through hyperlinks contained in margin comments.  

Using the Template 
The Template is intended to be used in conjunction with the OVW Checklist, which is 
incorporated into the STOP Formula Grants Program solicitation package, and the IP Guidance 
Tool, produced by the STAAR Project. While some guidance is included in the Template in 
comment boxes located in the margins, more extensive information appears in the IP Guidance 
Tool.   

This section outlines how to format, change and update the Template using Microsoft Word 
(consult the IP Guidance Tool for contextual information). The instructions assume a working 
knowledge of Microsoft Word. Please contact the ALSO STAAR Project for assistance with the 
Template or accompanying documents. ALSOSTAARProjectTA@also-chicago.org.  

Formatting – The formatting of the Template follows the requirements outlined in the OVW 
Checklist and the IP Guidance Tool. The IP Guidance Tool includes a set of formatting 
recommendations.  

Table of Contents – The Template Table of Contents was created using Microsoft Word Styles. It 
is set up to capture only the main Headers, using the style “Tool Section Header.”  

To update the Table of Contents page numbers in the final document: 

 Go to the References menu;  

 In the Table of Contents Tab, select Update Table.  

 A box will appear asking whether you want to update the page numbers only or re-do the 
entire table.  

 Check “entire table” if you have included additional headings that you would like to appear 
in the Table of Contents.  

 Select page numbers only if the only thing that has changed are page numbers.  

 To ensure that a new heading is included in the Table, highlight the heading, and select Styles 
in the Home tab. Then select Tool Section Header from the list of Styles.  

For more information about creating and updating a table of contents, refer to Microsoft Word 
help.  

Adding Content – To add content and save as a Word document: 

 Go to File > Save as. 

http://also-chicago.org/training-and-consultation/staar-project/tools-resources/implementation-planning-resources/new-stop-implementation-plan-template-packet-for-administrators/
http://also-chicago.org/training-and-consultation/staar-project/tools-resources/implementation-planning-resources/new-stop-implementation-plan-template-packet-for-administrators/
mailto:ALSOSTAARProjectTA@also-chicago.org
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 Select the location where you want to save the file. 

 Give the document a unique title. 

 Select Word Document under the Save as type drop-down list.  

When adding text to any of the sections or subsections in the Template – 

 Mouse over the placeholder text until it is highlighted in gray. 

 Place your cursor in the gray rectangle.  

 An outline will then appear around the text, along with a labeled tag at the top (e.g., 
“Introduction”).  

 To begin typing text in the box, click on the tag once.  

 The placeholder text should then appear highlighted in a darker gray.  

 You can then begin typing text in the box.  

 Once you begin typing, all of the placeholder text will immediately be replaced by the new 
text. 

 To eliminate the content control bounding boxes altogether, place your cursor in the box, 
right click, and select “Remove Content Control.” The box boundaries and tag will be deleted 
but the placeholder content will remain. 

Title Page – State and Territory Implementation Plan title pages vary in style and content. The 
Template title page contains the most common elements found in recent STOP IPs.  

To insert a State or Territory seal or logo – 

 Place your cursor in the State/Territory Seal box. 

 Go to the Insert tab.  

 Select Picture. You will be prompted to locate and select the image that you wish to place in 
the document.  

Using the Margin Comments – The page length suggestions, tips, cross-references, and other 
guidance contained in the comment boxes in the margins of the Template are intended to 
provide helpful information during the development of a STOP IP. They can be deleted at any 
time – as you insert content for the topic a comment addresses, upon completion of a section, 
or when the entire IP is finalized.  

To delete a comment box:  
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 Place your cursor in it.  

 Right click; and 

 Select “Delete Comment.”  

Page Numbers – These have been pre-inserted into the Template in the bottom right-hand 
corner of each page.  

Headers – A standard header that identifies the document as the STOP Implementation Plan 
appears in the corners of each page beginning on the page following the Table of Contents. 
Brackets indicate where the State or Territory name should be inserted, along with the year of 
the plan. The header is completely customizable and can include additional or completely 
different text, if desired.  

 

 

STOP Formula Grant Planning Workbook 
The Workbook is an Excel workbook with worksheets for organizing and keeping track of 
individuals and entities involved in the STOP planning process, as well as data collected for 
specific sections in the STOP IP.   

There are four worksheets included in the workbook:  

 STOP Consultation Worksheet; 

 Tribal Consultation Worksheet; 

 Data Categories and Sources; and 

 Drop-down List Values.  

The intended purposes and uses of each of the worksheets are explained below.  

STOP Consultation Worksheet 
The STOP Consultation Worksheet is a worksheet created for the purpose of recording all 
activities associated with STOP planning processes. It can be used in conjunction with a set of 
planning committee participation forms that must be submitted with the STOP IP. Each must be 
filled out and signed by each planning committee member. Each form must contain the following 
required information:  
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 Notice of meetings;  

 Attendance at meetings; 

 Whether each member was provided with an opportunity to review the draft STOP IP, along 
with a summary of major concerns raised during the planning process; 

 Whether each member submitted comments on the draft; and 

 Whether each member received a copy of the final STOP IP and the summary of major 
concerns raised during the planning process.  

The STOP Consultation Worksheet is intended to serve as a place to record STOP administrator 
tasks and efforts throughout the STOP planning process including: 

 Invitations extended to STOP planning committee members and participants in the larger 
consultation;  

 Invitee responses and participation;  

 Significant dates;  

 Input received about the draft STOP IP; and  

 Whether the input was incorporated into the final IP. 

Drop-Down Lists – Many of the fields contain drop-down lists that allow for quick data entry into 
the worksheet. For example, the Statutory Category field allows for identification of the type of 
entity an individual represents (e.g., law enforcement). Each cell in the column contains a drop-
down list of the eight required categories, as well as “Other.” In the adjacent column there is a 
space to record any category to which a committee member belongs that does not fit into the 
statutory categories listed in the drop-down. Where a column asks for a yes or no answer, a drop-
down with these options is provided in each cell. A notification that a drop-down list is available 
appears when a cell with a drop-down list is selected. 

Tribal Consultation Worksheet 
The Tribal Consultation Worksheet is designed to help with documenting outreach to and 
consultation with Tribes located within State borders. It is solely a tool for recording efforts and 
therefore does not provide technical assistance on identification of individuals within a Tribe who 
have knowledge of the subject matter and current issues. Technical assistance on these topics is 
available from the STAAR Project and project partners.  

The worksheet provides a place to record initial communication efforts with Tribal contact 
persons. The process of consultation with a Tribe may begin with outreach to staff working in the 
Tribal domestic violence program or another victim advocacy program, family or human service 
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programs, the health center, the community center, or a children’s program. This may be 
particularly true if the State has previously conducted minimal outreach or consultation with the 
Tribe related to the STOP Program. While States must consult with the Tribal governments of all 
Federally-recognized and State-recognized Tribes within a State, the richest information about 
issues, challenges, and needs may be obtained from those who work directly with survivors, 
within Tribal criminal justice agencies, or in legal services.  

For this reason, there are spaces to record how each contact person was identified, and why they 
are considered key for purposes of outreach to the Tribe and participation in the State planning 
process. There may be several contact persons for each Tribe that participate in the STOP 
consultation process. There is a place to record whether the initial contact represents a shelter 
or otherwise serves as a victim advocate, using a yes/no drop-down list, as well as whether the 
contact is a Tribal leader. In some cases, the contact may be both.  

Recording Outreach – The worksheet provides fields for recording up to three separate outreach 
methods, the dates of attempted contact, and the responses received. The worksheet can be 
expanded to include additional outreach attempts, as needed. Drop-down lists are provided 
under the Outreach Method columns. These lists can be modified to add or delete methods used 
using the same technique explained in the STOP Consultation Worksheet.  

If any of the initial contacts are asked to recommend possible participants in the STOP planning 
committee or the larger consultation, the contact information for each of the recommended 
individuals can be recorded in the worksheet. There is also a space to note the rationale for the 
recommendation.  

Once you have identified individual Tribal representatives who will participate in the planning 
committee or larger consultation, their contact information should also be included in the STOP 
Consultation Worksheet.  

Data Categories and Sources 
The third worksheet in the workbook is the Data Categories & Sources sheet. The sheet 
provides a place to record data sources and a summary of key findings for data that is required 
for the following STOP IP sections: 

II(A) – Demographic Information on State/Territory Population. This section includes fields to 
record the data categories (STOP IP-required categories are pre-filled), data sources, and a 
summary of key findings for each data category.  

II(B) – Underserved Populations Within State/Territory. This section includes a field to record 
for each underserved population, the methods used to identify an underserved population, 
along with data sources, and a summary of key findings for each.  
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V(B)(2) – Domestic Violence Homicides. This section includes fields for recording data for 
specific municipalities or counties, data sources, the number of domestic violence homicides in 
a particular jurisdiction, the domestic violence homicide rate, and the rate of all homicides.  

Drop-down List Values 
The final worksheet in the workbook is the Drop-down List Values sheet. This worksheet contains 
all of the items contained in the drop-down lists in the STOP Consultation Worksheet and the 
Tribal Consultation Worksheet. The drop-down lists are customizable, allowing items to be added 
or deleted.  

To add or delete an item: 

Go to the list to be changed within the Drop-down List Values worksheet.  

To add an item – type the new value in the appropriate list.  

To delete an item –  

 Right-click on it. 

 Click on Delete then Okay to shift cells up.  

To complete the process for both adding and deleting items –  

 Go to the Formulas tab in the ribbon1 and click on Name Manager. 

 In the Name Manager box, click Named Range to update the list. 

 In the Refers To dialog, click the icon on the right to collapse the dialog box (if necessary). 

 Then, on the worksheet, select all of the cells that contain entries for the items that should 
appear in the updated drop-down list.  

 Click on the icon on the right to expand the dialogue box, if necessary.  

 Click Close and then Yes to save the changes. 

For assistance with the drop-down list values or anything else related to the Template or Excel 
workbook, contact the STAAR Project at ALSOSTAARProjectTA@also-chicago.org.   

                                                        
1 The ribbon, found in Microsoft Word 2007 and later versions, combines the menu bar and toolbar, and is, by 
default, located at the top of the screen in Microsoft Office applications including Word, Excel, PowerPoint, and 
Outlook. techterms.com/definition/ribbon.  

mailto:ALSOSTAARProjectTA@also-chicago.org
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STOP Violence Against Women Formula Grant Program 
 Implementation Planning Participation  

[The fillable PDF version of this form is available on the STAAR Project website.] 

 
Please send back to ________________ at ___________________ by _______________. 

 
State/Territory: _______________________________________________________________ 
 
Administering Agency: __________________________________________________________ 
 
Participant Agency: _____________________________________________________________ 
 
Type of Agency: (Courts, Domestic Violence Coalition, Dual Coalition, Law Enforcement, 
Population Specific Organization, Prosecution, Sexual Assault Coalition, Tribal Coalition, Tribal 
Organization, Other State Agency, Other)  
 
If population specific organization, please specify which population: __________________________ 
 
Other: ___________________________________________ 
 
Planning Team Meeting Date(s): ______________________________________________________ 
 
Did you receive notification of meeting dates at least one month in advance?    Yes       No 
 
How were you notified? (check all that apply)  
          
   Email            In-person            Phone call            Website post            Letter            Other:_________ 
 
Were you able to participate in the meetings?  Yes     No 
 
If yes, how many meetings did you attend?   All     Some 
 
Meeting format: (check all that apply) Teleconference       Video conference       In-person 
 
If no, please explain: ___________________________________________________________________ 
 
During the meeting(s), were you able to freely provide input,  Yes       No         Partially 
ask questions, share concerns, and propose goals?  
 
Did you receive a draft of the Implementation Plan and a list   Yes       No 
of major concerns raised during the planning process?   
 
If no, please explain: ___________________________________________________________________ 
 
Were you given at least one month to review the draft plan?   Yes  No 
 
If no, please explain: ___________________________________________________________________ 

http://also-chicago.org/also_site/wp-content/uploads/2019/04/IP-Participation-Form-04.2019.pdf
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Were the major concerns raised during the planning process   Yes No 
included in the draft plan?   
 
If no, please explain: ___________________________________________________________________ 
 
Did you provide comments or recommended changes to the draft plan?    Yes No 
 
Did you receive a copy of the Final Implementation Plan?     Yes No 
 
If no, please explain: ___________________________________________________________________ 

If applicable, do you believe your recommended changes to the draft plan were adequately 
addressed in the Final Implementation Plan?  Yes               No               Not applicable                              
 
If no, please explain: ___________________________________________________________________ 
 
Overall, were the feedback, concerns, recommended goals, etc. of planning     Yes  No 
group participants adequately reflected in the Final Implementation Plan?    
  
 
If no, please explain: ___________________________________________________________________ 
 
Do you have any concerns with the content of the Final Implementation Plan?         Yes      No 
 
If yes, please explain: __________________________________________________________________ 
 
Name ______________________________ 
Signature ___________________________ 
Date_______________________________ 
 
 
 
 





 

 
 

STOP Formula Grants Program 
PURPOSE OF PROGRAM AND GRANT FUNDS 

General Program Purpose 

The purpose of the STOP Formula Grants Program (STOP Grants) is to assist States, State and 
local courts (including juvenile courts), Indian tribal governments, tribal courts, and units of 
local government to: 

 Develop and strengthen effective law enforcement and prosecution strategies to combat 
violent crimes against women; and to 

 Develop and strengthen victim services in cases involving violent crimes against women. 

Purposes for Which Grants May Be Used 

STOP Grants provide personnel, training, technical assistance, data collection, and other 
resources for the more widespread apprehension, prosecution, and adjudication of persons 
committing violent crimes against women for the protection and safety of victims, and 
specifically, for the purposes of --  

1) Training law enforcement officers, judges, other court personnel, and prosecutors to more 
effectively identify and respond to violent crimes against women, including the crimes of 
domestic violence, dating violence, sexual assault, and stalking, including the appropriate use of 
nonimmigrant status under subparagraphs (T) and (U) of section 101(a)(15) of the Immigration 
and Nationality Act (8 U.S.C. 1101(a));  

2) Developing, training, or expanding units of law enforcement officers, judges, other court 
personnel, and prosecutors specifically targeting violent crimes against women, including the 
crimes of domestic violence, dating violence, sexual assault, and stalking;  

3) Developing and implementing more effective police, court, and prosecution policies, protocols, 
orders, and services specifically devoted to preventing, identifying, and responding to violent 
crimes against women, including the crimes of domestic violence, dating violence, sexual assault, 
and stalking, as well as the appropriate treatment of victims;  

4) Developing, installing, or expanding data collection and communication systems, including 
computerized systems, linking police, prosecutors, and courts or for the purpose of identifying, 
classifying, and tracking arrests, protection orders, violations of protection orders, prosecutions, 
and convictions for violent crimes against women, including the crimes of domestic violence, 
dating violence, sexual assault, and stalking;  



 

 
 

5) Developing, enlarging, or strengthening victim services and legal assistance programs, including 
domestic violence, dating violence, sexual assault, and stalking programs, developing or 
improving delivery of victim services to underserved populations, providing specialized domestic 
violence court advocates in courts where a significant number of protection orders are granted, 
and increasing reporting and reducing attrition rates for cases involving violent crimes against 
women, including crimes of domestic violence,  dating violence, sexual assault, and stalking;  

6) Developing, enlarging, or strengthening programs addressing the needs and circumstances of 
Indian tribes in dealing with violent crimes against women, including the crimes of domestic 
violence, dating violence, sexual assault, and stalking;  

7) Supporting formal and informal statewide, multidisciplinary efforts, to the extent not supported 
by State funds, to coordinate the response of State law enforcement agencies, prosecutors, 
courts, victim services agencies, and other State agencies and departments, to violent crimes 
against women, including the crimes of sexual assault, domestic violence, dating violence, and 
stalking;  

8) Training of sexual assault forensic medical personnel examiners in the collection and preservation 
of evidence, analysis, prevention, and providing expert testimony and treatment of trauma 
related to sexual assault;  

9) Developing, enlarging, or strengthening programs to assist law enforcement, prosecutors, courts, 
and others to address the needs and circumstances of older and disabled women who are victims 
of domestic violence, dating violence, sexual assault, or stalking, including recognizing, 
investigating, and prosecuting instances of such violence or assault and targeting outreach and 
support, counseling, and other victim services to such older and disabled individuals;  

10) Providing assistance to victims of domestic violence and sexual assault in immigration matters;  

11) Maintaining core victim services and criminal justice initiatives, while supporting complementary 
new initiatives and emergency services for victims and their families;  

12)  Supporting the placement of special victim assistants (to be known as “Jessica Gonzales Victim 
Assistants”) in local law enforcement agencies to serve as liaisons between victims of domestic 
violence, dating violence, sexual assault, and stalking and personnel in local law enforcement 
agencies in order to improve the enforcement of protection orders. Jessica Gonzales Victim 
Assistants shall have expertise in domestic violence, dating violence, sexual assault, or stalking 
and may undertake the following activities—  

(A) Developing, in collaboration with prosecutors, courts, and victim service providers, 
standardized response policies for local law enforcement agencies, including the use of 
evidence-based indicators to assess the risk of domestic and dating violence homicide and 
prioritize dangerous or potentially lethal cases;  



 

 
 

(B) Notifying persons seeking enforcement of protection orders as to what responses will be 
provided by the relevant law enforcement agency;  

(C) Referring persons seeking enforcement of protection orders to supplementary services (such 
as emergency shelter programs, hotlines, or legal assistance services); and  

(D) Taking other appropriate action to assist or secure the safety of the person seeking 
enforcement of a protection order; 

13) Providing funding to law enforcement agencies, victim services providers, and State, Tribal, 
Territorial, and local governments (which shall be known as the Crystal Judson Domestic Violence 
Protocol Program) to promote—  

(A) The development and implementation of training for local victim domestic violence service 
providers, and to fund victim services personnel, to be known as “Crystal Judson Victim 
Advocates,” to provide supportive services and advocacy for victims of domestic violence 
committed by law enforcement personnel;  

(B) The implementation of protocols within law enforcement agencies to ensure consistent and 
effective responses to the commission of domestic violence by personnel within such 
agencies (such as the model policy promulgated by the International Association of Chiefs of 
Police (“Domestic Violence by Police Officers: A Policy of the IACP, Police Response to 
Violence Against Women Project,” July 2003);  

(C) The development of such protocols in collaboration with State, Tribal, Territorial and local 
victim services providers and domestic violence coalitions.  

Any law enforcement, State, tribal, territorial, or local government agency receiving funding 
under the Crystal Judson Domestic Violence Protocol Program under paragraph (13) shall on 
an annual basis, receive additional training on the topic of incidents of domestic violence 
committed by law enforcement personnel from domestic violence and sexual assault 
nonprofit organizations and, after a period of 2 years, provide a report of the adopted 
protocol to the Department of Justice, including a summary of progress in implementing such 
protocol; 

14) Developing and promoting State, local, or tribal legislation and policies that enhance best 
practices for responding to domestic violence, dating violence, sexual assault, and stalking; 

15) Developing, implementing, or enhancing Sexual Assault Response Teams, or other similar 
coordinated community responses to sexual assault; 

16) Developing and strengthening policies, protocols, best practices, and training for law 
enforcement agencies and prosecutors relating to the investigation and prosecution of sexual 
assault cases and the appropriate treatment of victims; 



 

 
 

17) Developing, enlarging, or strengthening programs addressing sexual assault against men, 
women, and youth in correctional and detention settings; 

18) Identifying and conducting inventories of backlogs of sexual assault evidence collection kits and 
developing protocols and policies for responding to and addressing such backlogs, including 
protocols and policies for notifying and involving victims; 

19) Developing, enlarging, or strengthening programs and projects to provide services and responses 
targeting male and female victims of domestic violence, dating violence, sexual assault, or 
stalking, whose ability to access traditional services and responses is affected by their sexual 
orientation or gender identify, as defined in section 249(c) of title 18, United States Code; and 

20) Developing, enhancing, or strengthening prevention and educational programming to address 
domestic violence, dating violence, sexual assault, or stalking, with not more than 5 percent of 
the amount allocated to a State to be used for this purpose. 

Funding Categories 

State and Territorial grantees are required to make awards in accordance with the following 
formula: 

 At least 25% must be allocated for law enforcement; 

 At least 25% must be allocated for prosecutors; 

 At least 30% must be allocated for victim services. Of this amount, 10% must be 
distributed to culturally specific community-based organizations; and 

 At least 5% must be allocated to State and local courts (including juvenile courts). 

Not later than 2 years after the date of enactment of VAWA 2013, no less than 20% of the total 
award amount to a State must be allocated for programs or projects that meaningfully address 
sexual assault. The 20% must be taken from 2 or more funding allocation categories (i.e., law 
enforcement, prosecution, courts, victim services).  
 



 

 
 

VAWA Definitions 
This section contains definitions to terms used in this Tool. All definitions are taken from the 
Violence Against Women Act, 34 U.S.C. § 12291.  

Culturally Specific – Primarily directed toward racial and ethnic minority groups (as defined in 
section 1707(g) of the Public Health Service Act (42 U.S.C. 300u-6(g)).  

The Public Health Service Act defines “racial and ethnic minority groups” as follows (42 U.S.C. § 
300u-6(g)): 

(g) Definitions  

For purposes of this section:  

(1) The term “racial and ethnic minority group” means American Indians (including Alaska 
Natives, Eskimos, and Aleuts); Asian Americans; Native Hawaiians and other Pacific Islanders; 
Blacks; and Hispanics.  

(2) The term “Hispanic” means individuals whose origin is Mexican, Puerto Rican, Cuban, Central 
or South American, or any other Spanish-speaking country.  

Culturally Specific Services – Community-based services that include culturally relevant and 
linguistically specific services and resources to culturally specific communities. 

Law Enforcement – A public agency charged with policing functions, including any of its 
component bureaus (such as governmental victim services programs or Village Public Safety 
Officers), including those referred to in section 2802 of title 25 (25 U.S.C. § 2802). 

Population Specific Organization – A nonprofit, nongovernmental organization that primarily 
services members of a specific underserved population and has demonstrated experience and 
expertise providing targeted services to members of that specific underserved population. 

Population Specific Services – Victim-centered services that address the safety, health, economic, 
legal, housing, workplace, immigration, confidentiality, or other needs of victims in domestic 
violence, dating violence, sexual assault, or stalking, and that are designed primarily for and are 
targeted to a specific underserved population.  

Prosecution – Any public agency charged with direct responsibility for prosecuting criminal 
offenders, including such agency’s component bureaus (such as governmental victim assistance 
programs).  

State Domestic Violence Coalition – A program determined by the Administration for Children 
and Families under sections 10402 and 10411 of this title (42 U.S.C. §§ 10402 and 10411). 



 

 
 

State Sexual Assault Coalition – A program determined by the Center for Injury Prevention and 
Control of the Centers for Disease Control and Prevention under the Public Health Service Act (42 
U.S.C. 280b et seq.) 

Territorial Domestic Violence or Sexual Assault Coalition – A program addressing domestic 
violence or sexual violence that is –  

(A) An established nonprofit, nongovernmental territorial coalition addressing domestic violence or 
sexual assault within the Territory; or 

(B) A nongovernmental organization with a demonstrated history of addressing domestic violence 
or sexual assault within the Territory that proposes to incorporate as a nonprofit, 
nongovernmental territorial coalition.  

Tribal Coalition – An established nonprofit, nongovernmental Indian organization, Alaska Native 
organization, or a Native Hawaiian organization that – 

(A) provides education, support, and technical assistance to member Indian service providers in a 
manner that enables those member providers to establish and maintain culturally appropriate 
services, including shelter and rape crisis services, designed to assist Indian women and the 
dependents of those women who are victims of domestic violence, dating violence, sexual 
assault, and stalking; and 

(B) who is comprised of board and general members that are representative of- 

(i) the member service providers described in subparagraph (A); and 

(ii) the tribal communities in which the services are being provided. 

Tribal Government – 

(A) The governing body of an Indian tribe; or 

(B) A tribe, band, pueblo, nation, or other organized group or community of Indians, including any 
Alaska Native village or regional or village corporation (as defined in, or established pursuant to, 
the Alaska Native Claims Settlement Act (43 U.S.C. 1601 et seq.)) that is recognized as eligible for 
the special programs and services provided by the United States to Indians because of their status 
as Indians.  

Underserved Populations – Populations who face barriers in accessing and using victim services, 
and includes populations underserved because of geographic location, religion, sexual 
orientation, gender identity, underserved racial and ethnic populations, populations underserved 
because of special needs (such as language barriers, disabilities, alienage status, or age), and any 
other population determined to be underserved by the Attorney General or by the Secretary of 
Health and Human Services, as appropriate.  



 

 
 

Victim Service Provider – A nonprofit, nongovernmental or tribal organization or rape crisis 
center, including a State or tribal coalition, that assists or advocates for domestic violence, dating 
violence, sexual assault, or stalking victims, including domestic violence shelters, faith-based 
organizations, and other organizations, with a documented history of effective work concerning 
domestic violence, dating violence, sexual assault, or stalking.  

Victim Services or Services – Services provided to victims of domestic violence, dating violence, 
sexual assault, or stalking, including telephonic or web-based hotlines, legal advocacy, economic 
advocacy, emergency and transitional shelter, accompaniment and advocacy through medical, 
civil or criminal justice, immigration, and social support systems, crisis intervention, short-term 
individual and group support services, information and referrals, culturally specific services, 
population specific services, and other related supportive services.  

 


